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INTRODUCTION 

 

 Si les forêts tropicales ont depuis longtemps suscité l’intérêt des romanciers, 

explorateurs et scientifiques, elles ont été plus récemment mises au centre des débats 

environnementaux internationaux [GIEC, IPPC, 2016]. En effet, elles apparaissent comme un 

enjeu de premier ordre de par leur rôle essentiel dans l’équilibre climatique, la préservation de 

la biodiversité, ainsi que dans la vie de nombreux peuples autochtones [Mille et al., 2015].  

 Les forêts tropicales humides d’Afrique centrale constituent le deuxième plus grand 

massif mondial et s’étendent sur près de 2 millions de km
2
 [Verhegghen et al., 2012]. Ces 

forêts sont un des écosystèmes terrestres les plus diversifiés de la planète [Hart et al.,1989]. 

Pour illustrer cette richesse, certains chercheurs ont comparé leur potentiel écosystémique aux 

forêts des latitudes tempérées. A surface égale les forêts tropicales humides comptent entre 5 

à 10 fois plus d’espèces de plantes vasculaires que les forêts tempérées. On y dénombre plus 

de 200 espèces d’arbre par hectare (une quinzaine en forêts tempérées) avec une densité de 

peuplement de  600 à 700 individus (diamètre  supérieur  à 10 cm à 1,3m  du sol). Pour une 

surface équivalente à la superficie de la région Ile de France (10 000km
2
), on recense en forêts 

tropicales humides entre 250 et 600 espèces d’oiseaux (10 à 300 en forêts tempérées), 75 à 

220 espèces de mammifères  (10 à 90 en forêts tempérées). La  spécificité des forêts tropicales 

humides d’Afrique centrale à l’échelle mondiale est marquée par la présence de nombreuses 

espèces endémiques [Doumenge, 2015].  

 Bien que l’on connaisse la richesse des milieux forestiers tropicaux humides d’Afrique 

centrale, leur fonctionnement écologiques et leur organisation géographique demeurent 

encore largement méconnus. Plusieurs facteurs limitent les investigations scientifiques : 

l’étendue des forêts tropicales humides, la difficulté d’accès aux terrains d’étude, et les 

conditions géopolitiques complexes. De ce fait,  les connaissances géographiques des forêts 

tropicales humides restent encore très localisées et peu développées à l’échelle de l’Afrique 

centrale [Betbeder et al., 2014]. Pour pallier à ces inconvénients la télédétection apparait de 

plus en plus comme un outil d’investigation indispensable mais reste encore incomplet dans 

l’identification des peuplements forestiers (Gond et al., 2013). Dans ce contexte l’analyse 

d’espèces forestières agrégatives et mono-dominantes est une première étape. D’une part elles 

représentent un enjeu technique pour être identifiées, localisées et cartographiées. D’autre part 

elles sont susceptibles d’être exploitées par les compagnies forestières à brève échéance. En 

effet une espèce particulière comme le G. dewevrei risque d’être au cœur d’enjeux 

économiques de par ses propriétés technologiques et son accessibilité (présence de plaques 

agrégatives de plusieurs milliers d’individus). Il est probable que cette espèce soit soumise à 

une forte exploitation dans les années à venir (Sylvie Gourlet-Fleury communication 

personnelle). Il est donc prioritaire de mieux appréhender sa répartition spatiale afin de 

donner des préconisations d’aménagement et d’exploitation auprès des acteurs de la filière 

forestière en Afrique centrale. 

 

Notre hypothèse de travail est de savoir s’il est possible par télédétection spatiale de 

cartographier des peuplements mono-dominants typiques des forêts tropicales humides 

d’Afrique centrale. Afin de répondre à cette hypothèse nous allons tenter de réaliser une 
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représentation cartographique des peuplements mono-dominants à G. dewevrei à l’échelle de 

l’Afrique centrale. 

 

  

   

 

 Cette étude s’inscrit dans le cadre des projets Dynaffor (Dynamique des Forêts 

d’Afrique Centrale, http://www.dynaffor.org/) et de l’OFAC (Observatoire des Forêts 

d’Afrique Centrale, http://observatoire-comifac.net/). L’étude se base sur un travail 

préparatoire ayant utilisé des données SPOT, LANDSAT, MODIS et des photographies 

aériennes pour identifier le G. dewevrei au nord de la République du Congo [Alverhne, 2014].  

 

 Ce rapport  décrit  dans un premier chapitre les données utilisées et la démarche 

méthodologique utilisée, puis expose dans un second chapitre les résultats, suivi dans un 

troisième chapitre d’une discussion sur  les intérêts et les limites de l'étude. 

 

DONNEES ET METHODES 

Le  Gilbertiodendron Dewevrei 
 

 Le  G. dewevrei, est identifiable sur des images satellites grâce à certaines de ses 

caractéristiques écologiques [Letouzey, 1985 ; Doumenge, 2012].  

 

 On le distingue d’une part grâce à ses traits physiques particuliers :   

 

- notre arbre est sempervirent, sa canopée est visible tout au long de l’année, contrairement à 

un arbre caduc dont les variations dans la feuillaison peut modifier le signal de réflectance 

capté par satellite selon les saisons de l’année. Ceci nous permet de sélectionner des images 

seulement en fonction de la présence ou non de nébulosité.   

 

-il est mono-dominant. Il pousse de façon grégaire et ses peuplements sont généralement 

observés sous forme de grandes plaques presque pures
1
 qui peuvent couvrir  parfois plus de 10 

000 ha. Même si sa canopée atteint la même taille que celle de la forêt mixte qui l’entoure, les 

deux  forêts présentent des apparences totalement différentes. G. dewevrei est identifiable car 

sa canopée est plus sombre que celle des forêts mixtes environnantes. Sa canopée est 

homogène, et formée de cimes profondes et étroites, tandis que celles des forêts mixtes 

environnantes sont plus hétérogènes.  

 

- on peut noter que la cime de G. dewevrei compte généralement pour plus de la moitié de la 

taille de l’arbre avec un diamètre de  pas moins de 15 m, soit une surface visible sur un 

demi pixel [Hart et al.,1989 ; Gérard, 1960 ; T. Hart, pers. Obs].  

 

- les forêts de G. dewevrei possèdent peu de sous bois qui peut venir interférer avec le signal 

de réflectance. En effet, selon Doumenge, en  R.D. du Congo, ces peuplements se composent 

normalement de 3 strates ; une strate supérieure arborée continue formée presque 

exclusivement de G. dewevrei, au milieu de laquelle apparaît par endroits la cime d’une autre 

                                                 
1
 G. dewevrei couvre 75–88% de la surface terrière [Doumenge, 2012; Letouzey, 1985] 
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essence héliophile de grande taille (par ex. Anthonotha fragrans (Baker f.) Exell & Hillc., Dialium 

corbisieri Staner, Irvingia wombolu Vermoesen, Prioria oxyphylla (Harms) Breteler et Staudtia 

kamerunensis Warb.)  suivie d’une strate intermédiaire peu dense : principalement composée 

de jeunes G. dewevrei mélangés à quelques rares semi-héliophytes (comme Diogoa zenkeri 

(Engl.) Exell & Mendonça, Garcinia punctata Oliv. et Synsepalum subcordatum De Wild.) et à 

des arbustes (par ex. Alchornea floribunda Müll.Arg. et Isolona thonneri (De Wild. & T.Durand) 

Engl. & Diels), et enfin, une strate herbacée discontinue à Marantaceae et à Commelinaceae.  

 

 D’autre part, les connaissances même morcelées de son implantation géographique 

nous permettent de cibler nos prospections concernant ses peuplements :  

 

-cette espèce endémique est présente dans des régions au-dessous de 1000 m d’altitude, dans 

des zones où la pluviométrie annuelle moyenne est de l’ordre de 1600–1900 mm et où la saison 

sèche dure 2 mois environ [Doumenge, 2012]. 

 

-il pousse principalement dans les dépressions humides, les vallées alluviales, le long des rivières, 

et également en altitude (plateaux, sommets des collines, interfluves) [Doumenge, Letouzey]. 

Toutefois les avis d’expert son partagés là-dessus,  pour Letouzey par exemple G. dewevrei est 
présent dans des vallées mais sur sol secs, à l’abri des inondations temporaires ou permanentes et 

hors de tout terrain marécageux.  

 

- En ce qui concerne sa localisation à une échelle plus large, les forêts dominées par G. dewevrei 

sont principalement situées sur les plateaux entourant le bassin central du fleuve Congo.  Elles 

apparaissent également en petites plaques dans les forêts du centre du bassin lui-même, en 

Centrafrique, au Cameroun et au Gabon [Lebrun et Gilbert 1954, Letouzey 1970]. En outre, on 

trouve les peuplements les plus étendus, au nord et nord-est du Bassin du Congo, et en République 

Démocratique du Congo, où ces forêts sont considérées comme la végétation climacique 

[Doumenge, 2012]. 
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Tableau 1 -- Intérêt méthodologique des caractéristiques écologiques du G. dewevrei 

 

Caractéristiques écologiques  

 

 

Intérêt méthodologique 

 

Source 

 

 

Phénologie : Sempervirent 

 

Observable toute l’année, la 

sélection des images ne dépend 

que de la nébulosité 

 

 

Doumenge, 2012 ; Letouzey, 

1985 

 

*Monodominant : pousse en 

plaques de quelques dizaines 

à 10 000 ha, généralement 

entouré de forêts mixtes   

 

*Canopée large (15 m 

minimum par arbre) 

 

* Feuillage sombre et 

homogène qui se  distingue 

des cimes de forêts mixtes 

hétérogènes 

 

 

Objet identifiable par photo-

interprétation, à la résolution 

des images LANDSAT 8 

(pixel=30m), et dont les valeurs 

de réflectance caractéristiques 

le rendent potentiellement 

classifiable grâce à un 

algorithme 

 

Doumenge, 2012 ; Letouzey, 

1985 ;  Hart et al., 1989 

 

Sous-bois peu dense 

 

 

Peu d’interférences avec les 

ondes lumineuses notamment  

infra-rouge (interaction avec le 

feuillage) qui modifieraient les 

valeurs de réflectance.   

 

  

Guyot, Baret, 1988 

 

*Localisation géographique : 

arbre endémique de l’Afrique 

centrale.  

 
**Petites plaques dans les 

forêts du centre du bassin du 

Congo, en Centrafrique, au 

Cameroun et au Gabon.  

 

**Peuplements les plus 

étendus, au nord et nord-est 

du Bassin du Congo, et en 

République Démocratique 

du Congo 

 

Les images sont sélectionnées 

dans cette zone pour la 

prospection. 

 

Léonard, 1953, Rollet, 1963 ; 

Letouzey, 1985 ; Hart et al., 

1989 ; Viennois, 2000 ; 

Doumenge, 2012  
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Les images LANDSAT 8 

Le téléchargement des images  

 

 Pour réaliser ce travail de prospection nous avons sélectionné des images produites par 

le capteur LANDSAT 8, grâce au radiomètre OLI (Operational Land Imager). Ces données 

ont un certain nombre d’avantages, elles sont en accès gratuit sur la plateforme de 

téléchargement EARTH EXPLORER du site de l’USGS (http://earthexplorer.usgs.gov/), tout 

en ayant une résolution spatiale fine (les pixels représentent une surface de 900m
2
) [Adam, 

2015].   

 

 

 LANDSAT 8, est le huitième et le plus récent de sa génération au sein du programme 

LANDSAT. Ce programme spatial d’observation de la Terre est le premier à être dédié à des 

fins civiles. Il a été développé par l’agence spatiale américaine civile National Aeronautics 

and Space Administration (NASA), à l’instigation de l’Institut des études géologiques 

américain (USGS) et du département de l’agriculture au milieu des années 1960. 

 

  Voici ci-dessous les caractéristiques du capteur en question : 

 
Tableau 2 -- Les caractéristiques du capteur OLI (LANDSAT 8) 

 
 

Source : Adam, 2015 

 

 

Chaque tuile LANDAST 8 couvre une zone de 180 x 180 km. Ainsi, pour couvrir la 

zone sur laquelle nous avons prospecté
2
, nous avons dû acquérir 27 tuiles. 

 

 

 

 

 

 

 

                                                 
2
 874 800 km

2
 s’étendant de l’est du Gabon à la part nord-est de la République Démocratique du Congo, nous 

avons cherché à couvrir la zone délimitée par Charles Doumenge à partir de plusieurs cartes locales (cf  Figure 1 

). 

http://earthexplorer.usgs.gov/
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Figure 1 –  Ensemble des tuiles LANDSAT8 téléchargées 

 

 Cette part du travail est chronophage car le téléchargement via le site de l’USGS se 

fait en plusieurs étapes ; commande des images scène par scène, validation par l’USGS de la 

commande, mise à disposition des images grâce à un lien de téléchargement envoyé par mail, 

et temps de téléchargement final.  

 

Les images que nous avons téléchargées sont déjà prétraitées et les valeurs spectrales 

correspondent aux valeurs de réflectance au  sol. Etant donné le nombre d’images à traiter, il 

est essentiel de récupérer ces images prétraités (grâce à des modèles élaborés par la NASA) 

pour deux raisons, les procédés sont automatisés et basés sur le modèle de corrections 

181_57    185_57 

   185_58   184_58   183_58   182_58   181_58 

185_59   184_59   183_59  182_59   181_59 
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175_60 
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atmosphériques 6S (ce qui évite les erreurs liés à d’éventuels problèmes de calculs), en outre, 

cette étape de calcul (passage des valeurs de comptes numériques initiaux en réflectance au 

sol) est relativement longue on économise ainsi un temps précieux. 

 

 
 

 Localisation de la scène                               Sélection d’images LANDSAT 8 

                                                                    en réflectance au sol (sr) 

 

 
 
Source : http://earthexplorer.usgs.gov/, 2016 

 

 
Figure 2 -- Sélection des tuiles LANDSAT 8 en réflectance au sol (site de l’USGS) 

Les informations concernant la localisation géographique de la tuile, la date 

d’acquisition, l’unité des valeurs de pixels sur l’image (réflectance au sol notamment) ainsi 

que la bande spectrale concernée sont contenues dans le nom des tuiles. Dans l’image 

suivante par exemple : LC81820582013353LGN00_sr_band6.tif : 

http://earthexplorer.usgs.gov/
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 182 / 058 correspondent aux coordonnées WRS  (respectivement numéro de Path 

(colonne) et Row (ligne))  du centre de la tuile Landsat dans le système WRS 

(Worldwide Reference System) développé par la NASA pour référencer les images 

Landsat collectées. Ces coordonnées dans le WRS correspondent aux coordonnées 

UTM décimales suivantes : longitude : 16.3576, latitude : 2.8933.3 

 2013/353 correspondent respectivement à l’année et au jour du calendrier julien 

date à laquelle l’image a été captée.  

 « sr » nous assure des valeurs de pixels en réflectance au sol.  

 band6  nous renseigne sur la bande spectrale et la longueur d’onde exploitée, ici le 

moyen infra-rouge (1,57 - 1,65 µm). 

  Nous avons plus récemment pris connaissance du site canadien 

https://remotepixel.ca/projects/satellitesearch.html qui rend l’accès aux images LANDSAT 8 

(mais également SENTINEL) plus aisé et intuitif. 

 

  Il reste toutefois complémentaire au site de l’USGS car pour le moment  il ne donne 

pas accès aux images dont les valeurs de pixels sont en réflectance au sol, certaines images 

aux dates les plus anciennes ne sont pas accessibles
4
. De plus les images ne sont pas 

utilisables directement dans ENVI, il est nécessaire de les calibrer (renseigner les paramètres 

de numéro de bande, nombre de lignes, colones, type de codage…) ce qui rend la 

manipulation un peu longue lorsqu’elle est réalisée image par image, alors que ceci n’est pas 

nécessaire pour les images obtenues au format « SR » via le site de l’USGS. Il reste 

intéressant pour visualiser de manière aisée l’emplacement des tuiles LANDSAT sur le globe.  

Bandes spectrales utilisées 

 

Sur l’ensemble des bandes spectrales téléchargées pour chaque tuile nous avons fait 

usage des suivantes:  

 
 Tableau 3 -- Bandes spectrales utilisées  

 

N° de bande 

 

 

Domaine spectrale / type de 

pollution atmosphérique  

identifiée 

 

 

Longueur d’onde  

Bande 1 Aérosols 0,43 - 0,45 µm 

Bande 2 Bleu 0,45- 0,51 µm 

Bande 4 Rouge 0,64 - 0,67 µm 

Bande 5 Proche Infra Rouge (PIR) 0,85 - 0,88 µm 

Bande 6 Moyen Infra Rouge (MIR) 1,57 - 1,65 µm 

Bande 9 Cirrus 1,36 - 1,38 µm 

   

                                                 
3
 http://landsat.usgs.gov/worldwide_reference_system_WRS.php 

4
 Ceci est problématique lorsqu’elles présentent très peu de nébulosité.  

https://remotepixel.ca/projects/satellitesearch.html
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Méthode 

Tri préliminaire des images selon la nébulosité 

 

 La zone tropicale mais surtout équatoriale, sur laquelle porte notre étude, est connue 

pour être soumise à une nébulosité importante tout au long de l’année. Cette difficulté doit 

être prise en compte et limite l’automatisation des traitements. Pour obtenir les images 

permettant de produire la carte finale, il est nécessaire de réaliser une série de tris successifs 

des scènes au cours de la méthode que nous avons suivi et obtenir des images dans lesquelles 

les peuplements de G. dewevrei sont susceptibles d’être extraits du mieux possible.   

 

 Une premier tri des scènes est effectué, depuis la plateforme de téléchargement de 

l’USGS. L’onglet « Add criteria »  permet par exemple de sélectionner les images possédant 

moins de 10% de nébulosité.  

 

                   
                         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

Source : http://earthexplorer.usgs.gov/, 2016 

 
Figure 3-- Sélection des tuiles avec peu de nébulosité (site USGS) 

http://earthexplorer.usgs.gov/
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Tri post téléchargement 

 

 Nous avons ensuite réalisé un  tri post-téléchargement pour ne garder que les images 

les moins parasitées par les aérosols et de la vapeur d’eau  en visualisant pour les différentes 

scènes les bandes cloud (canal 9), aérosol (canal 1) et la bande bleue (canal 2).  

 

La bande cloud  affichée en palette « Gray Scale » permet de visualiser les pixels 

contenant de la vapeur d’eau et/ou des aérosols ( 

Figure 4 -- Visualisation de la nébulosité sur la tuile : 

LC8182582013353LGN00_sr_bandcloud.tif, ci-dessous), à partir d’un codage des 

valeurs de pixel en 2 bit (la valeur du pixel correspond à la valeur 2 exposant de la valeur du 

code cirrus (soit une valeur comprise entre 0 et 6) (Tableau 4 – Correspondance code cirrus 

codage en bitci-dessous). 

 
Sous ENVI 4.7 > Available Bands List > Gray Scale > Band1 : 

 LC8182582013353LGN_sr_bandcloud.tif> New Display> Load Band 
     

La bande 1 permet également de voir en quantité la présence d’aérosols en fonction 

des valeurs de réflectance des pixels. Plus les aérosols sont présents plus les valeurs de 

réflectance sont fortes plus la couleur du pixel tend du gris vers le blanc (Figure 5 – 

Visualisation. 

 
Sous ENVI 4.7 > Dans la fenêtre #1 Band1 : LC8182582013353LGN_sr_band1.tif> 

Tools>Cursor Location/ Value…. 

   

 
   Tableau 4 – Correspondance code cirrus codage en bit 

Code cirrus Code en 2 bit 

0= cirrus 2^0=1 

1=cloud 2^1=2 

2=adjacent to cloud 2^2=4 

3=cloud shadow 2^3=8 

4=aerosol 2^4=16 

5=aerosol 2^5=32 

6=unsused 2^6=64 
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Figure 4 -- Visualisation de la nébulosité sur la tuile : 

LC8182582013353LGN00_sr_bandcloud.tif 

 

 

 

 
 

 

 

 
 

 

 

 

 

 

 

 

 

Figure 5 – Visualisation de l’épaisseur d’aérosols sur la tuile : 
LC8182582013353LGN00_sr_band1.tif 
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La  méthode la plus efficace s’avère de comparer le canal du MIR d’une même 

tuile à différentes dates après qu’il ait été traité selon la méthode de mise en évidence des 

contrastes internes de l’image (cf partie Méthode finale) et de ne retenir que le canal MIR 

à la date où les contrastes internes à l’image sont les plus importants (de sorte que les 

peuplements de G. dewevrei soient bien visibles) et où les nuages apparaissent le moins. En 

effet nous avons retenu la bande 6 (MIR) comme indicateur unique de la présence du  G. 

dewevrei [Alverhne, 2014]. 

 

 

Tests initiaux 

Photo-interprétation  
 

 Avant de parvenir à la méthode finale, nous avons testé plusieurs pistes 

méthodologiques en nous concentrant sur la zone préalablement étudiée par Alvernhe, Heinzh 

et Roth (tuile LANDSAT 8 LC8182582013353). Nous recherchions une procédure qui soit à 

la fois simple et rapide dans le traitement des images.  

 

 Nous  avons d’abord cherché à identifier les plaques de G. dewevrei par photo-

interprétation à partir de composition colorée fausse couleur permettant d’analyser la 

végétation en  associant les canaux 6, 5 et 5 (Figure 6 – Composition colorée alliant les 

canaux 6, 5 et 4 de la tuile LANDSAT 8:  

LC8182582013353LGN00). Nous nous sommes appuyés pour cela sur le travail effectué par 

Lény Alverhne
5
 , localisation des peuplements de G. dewevrei également identifiés par 

Heinzh et Roth en 2009 (   

 Figure 7 – Cartographie du G. dewevrei par Heinzh et Roth, 2009). Nous avons ensuite 

cherché à établir des critères de teinte, texture-structure  (que nous détaillons plus bas dans le 

tableau) afin de pouvoir élargir notre méthodologie à l’ensemble de la zone d’étude.  

 
  Sous ArcGIS 10.2 > ArcToolbox > Data Management Tool > Raster > Raster Processing > 
 Composite Bands 

 

                                                 
5
 L’étude réalisée par Lény Alvernhe portait alors sur une zone de 180 km

2 
située à la jonction entre l’extrême est 

du Cameroun, le parc national de Dzangha-Ndoki au sud-ouest de la Centrafrique et le nord de la République du 

Congo (Figure 8 – Cartographie des peuplements de G. dewevrei par Lény Alvernhe en 2014 (à partir d’une  

image SPOT-5). 
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Figure 6 – Composition colorée alliant les canaux 6, 5 et 4 de la tuile LANDSAT 8:  

LC8182582013353LGN00 

    

 Figure 7 – Cartographie du G. dewevrei par Heinzh et Roth, 2009 

       Repérage des plaques 

  de G. dewevrei  

sur la composition colorée 6,5,4, 

validé par la carte de Heinz et 

Roth (2009) et par celle de Lény  

Alvernhe (2014) 
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Figure 8 – Cartographie des peuplements de G. dewevrei par Lény Alvernhe en 2014 (à partir d’une  image SPOT-5) 

   

 

Nous avons ensuite testé différentes méthodes de seuillage visant à extraire la 

signature spectrale des peuplements de G. dewevrei. Le seuillage permet d’éliminer de 

l’image l’ensemble des pixels dont la valeur de réflectance (ou d’indice) n’est pas comprise 

entre les bornes retenues.   
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Seuillage spectral et d’indice 
 

Le seuillage a été effectué à la fois sur les canaux 5 et 6, en excluant le canal 4 qui est 

trop sensible à la vapeur d’eau.  

 
Sous ENVI 4.7 > Available Bands List > R: LC8182582013353LGN_sr_band4.tif 
            G: LC8182582013353LGN_sr_band5.tif 
             B: LC8182582013353LGN_sr_band6.tif 
 
Dans la fenêtre > #1 R: LC8182582013353LGN_sr_band4.tif; 

 G:LC8182582013353LGN_sr_band5.tif ; B: LC8182582013353LGN_sr_band6.tif > Enhance > 
 Interactive Stretching.  

 
On place les bornes sur l’histogramme des valeurs de pixels de sorte à ne garder que les 

 objets spatiaux qui nous intéressent sur la bande affichée.  
 
Seuils retenus: Bande 5: [1975-2551], Bande 6: [873-1123] 
 
 

 

 
Figure 9- Composition colorée (6,5,4) obtenue suite au seuillage 
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Seuillage d’indice 
 

 Sachant que le G. dewevrei est sempervirent et mono-dominant nous avons supposé 

qu’il pouvait présenter une activité chlorophyllienne différente de celle des forêts mixtes 

alentours. Nous avons donc essayé de seuiller un indice de NDVI (PIR –R / PIR + R) connu 

pour mettre en évidence l’activité photosynthétique de la surface observée. Les valeurs 

négatives de NDVI correspondant aux zones de sols nu et celles positives à de la végétation 

chlorophyllienne dont l’activité est plus ou moins intense.    

 
Sous ENVI 4.7 > Basic Tools > Band Math >  

“(float (b1) – float (b2))/( float (b1) – float (b2))” 

 avec  b1 = LC8182582013353LGN_sr_band4.tif (rouge) 
et  b2= LC8182582013353LGN_sr_band6.tif (PIR) 

Ces différentes méthodes se sont avérées peu concluantes puisque elles dépendent des 

valeurs spectrales de chaque image. Ainsi, il semble difficile d’automatiser le seuillage 

puisque les seuils retenus pour une image ne seront pas les même d’une image à l’autre (les 

valeurs de réflectances pour un même objet peuvent varier de plusieurs unité selon la date de 

captation de l’image). D’autre part ces bornes ne permettent pas d’extraire parfaitement le G. 

dewevrei et  incluent généralement des objets spatiaux différents des peuplements mono-

dominants recherchés.   

 

Critères de photo interprétation retenus 
 

 Nous avons établi une grille de critères qui nous a servi de référence au cours de cette étude. 

 Comme nous le montrons précédemment dans la partie seuillage spectral et seuillage d’indices,  il  

 n’est pas possible d’établir des repères basés sur des valeurs d’indices ou de réflectance qui soient 

transversaux aux différentes tuiles puisque les valeurs varient d’une captation à l’autre. 

 

   Nous basons donc nos critères de photo-interprétation sur des caractéristiques de teinte/texture/ 

structure (plus modulables) définis à partir de la tuile LC8182582013353LGN00 pouvant s’adapter aux 

variations des valeurs
6
 de réflectance pour un même objet d’une tuile à l’autre.  

 

 

 

 

 

 

 

 

 

 

                                                 
6
 Ces variations peuvent être liées à différents paramètres ; la nébulosité mais aussi à l’angle d’ensoleillement de la scène qui 

crée un biais sur les valeurs de réflectance des objets observables (un différentiel d’ombrage (est-ouest)).   
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Tableau 5 – Critères de photo-interprétation retenus pour identifier les plaques denses de G. dewevrei 

 

Objet 

 

Plaques denses de G. dewevrei  (taux de recouvrement 

important avoisinant 

      les 80%) d’une superficie d’au moins un ha. 
 

 

Teinte  

 

Aspect plus foncé et homogène que la végétation 

alentours considérée comme principalement de la 

forêt mixte 

 

o Peuplements de G. dewevrei entouré de 

forêt mixte de teinte plus claire :  

 

 
Visualisation sur le canal du MIR ;                                 Composition colorée (6,5,4) ;                                    

Tuile : LC81820592015007                                                Tuile : LC81810582015016                                                 

                                          

 
Composition colorée (6,5,4) ; 

Tuile : LC81820592015007 

 

 

Texture 
 

Les plaques présentent un aspect cotonneux souvent 

plus rugueux que les milieux alentours.  
 

 

Struture 
Les plaques s’organisent en formes agrégatives qui vont de 11 pixels 

(1ha) minimum à 3000 pixels (300 ha) pour les plus grosses plaques. 

Ces agrégats ne sont pas toujours continus et peuvent se présenter sous 

la forme de petites tâches incluses dans une autre forêt (cf illustration ci-

dessus).   



 

21 

Méthode finale 

 

 Nous nous sommes arrêtés sur la méthode que nous décrivons à présent, pour produire 

la cartographie finale. Celle-ci se veut simple, semi-automatisée mais repose toutefois sur une 

grande part de photo-interprétation. Elle  nécessite une longue période de prise en main des 

images pour comprendre et analyser les différents milieux visibles à la résolution des images 

LANDSAT 8.  

 

 Il faut noter pour cela que les connaissances du milieu forestier tropical africain restent 

limitées, au regard des données disponibles. Il existe peu de cartes permettant d’identifier de 

manière précise les différentes composantes paysagères de l’Afrique centrale à une large 

échelle, celles-ci sont très détaillées mais à une échelle locale concernant des territoires 

réduits et dispersés au sein du bassin du Congo. Nous avons appuyé notre compréhension des 

différents types de milieux forestiers présents sur la zone en utilisant la carte « Tropical 

forests diversity in Central Africa using MODIS data », ainsi que la carte « Central Africa 

forested wetlands ».  

 

 La méthode peut être divisée en 4 étapes ; une première partie basée sur le concept de 

réhaussement des contrastes locaux au sein des images, une deuxième consistant à réaliser 

une classification non-supervisée sur les images filtrées, une troisième qui vise à sélectionner 

la classe contenant les peuplements de G. dewevrei [Lény Alverhne, 2014] et enfin une 

dernière durant laquelle nous avons converti la classe sous format raster en un fichier vecteur 

et avons réaliser un tri parmi les polygones obtenus sur la base de critères de photo-

interprétation (Tableau 5 – Critères de photo-interprétation retenus pour identifier les plaques 

denses de G. dewevrei) 

 

 Voici en détail le déroulé de chaque étape.  

Première étape : amélioration des contrastes locaux 
 

 Cette méthode basée sur le passage de filtres successifs a été élaborée précédemment 

par Lény Alverhne et s’avère particulièrement efficace.  Ce dernier l’a appliquée à un nombre 

réduit d’images SPOT par le biais du logiciel ENVI, dans notre cas, le traitement d’un nombre 

important de scènes LANDSAT a nécessité l’automatisation de ces traitements. Cette 

automatisation a été rendue possible en réalisant un code de commande sous R (cf script 

1_annexe), nous donnons ici en italique la procédure manuelle sous ENVI.  

 
1. Un filtre « Low pass » avec une fenêtre de calcul de 45 pixels par 45 pixels, est appliqué à la 

bande du Moyen Infra-Rouge (MIR) soit la bande 6.   

  

Sous ENVI 4.7 > Filter > Convolution and Morphology > Convolutions> LowPass 

Ce filtre est basé sur la moyenne. Il consiste à faire passer sur l’ensemble de 

l’image une fenêtre de calcul de taille variable. Plus la fenêtre de calcul est grande 

plus l’image obtenue sera floue et aura des valeurs moyennes représentatives de 

l’ensemble des contrastes de l’image et non pas des variations locales. Le pixel 

situé au centre de la fenêtre de calcul obtient la valeur équivalente à la moyenne de 

l’ensemble des pixels compris dans la fenêtre de calcul. Le choix de la fenêtre de 

calcul a été un compromis entre la nécessité d’une grande fenêtre et un temps de 
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calcul plutôt réduit.  On obtient ainsi une image qui représente les valeurs 

moyennes de la bande MIR initiale.     

 

 
2. On soustrait l’image des valeurs moyennes obtenue précédemment à la bande MIR initiale.  

 

Sous ENVI 4.7 > Basic Tools > Band Math > “float (b1) – float (b2)”  

avec  b1 = MIR_initiale   et  b2= MIR_filter_low_pass_1 

Ceci permet de gommer les valeurs moyennes de la bande MIR et de mettre 

davantage en évidence les éléments qui se démarquent par leurs valeurs 

spectrales extrêmes (renforcement des contrastes de l’image et mise en 

évidence des micro-variations de l’image). En termes statistique on augmente 

ainsi la variance inter groupe des pixels. 
 

 

3. On applique à nouveau le filtre « Low pass » avec la fenêtre de calcul de 45 pixels par 45 

pixels à l’image obtenue via la soustraction. 

Les valeurs obtenues sur l’image correspondent aux valeurs moyennes de la 

bande MIR initiale mais supérieures à celles pris en compte lors du premier 

passage de filtre. 

 
4. On soustrait à nouveau cette image des valeurs moyennes (plus hautes) obtenue 

précédemment à la bande MIR initiale.  

Sous ENVI 4.7 > Basic Tools > Band Math > “float (b1) – float (b2)”  
avec  b1 = MIR_initiale   et  b2= MIR_filter_low_pass_2 

 

On élimine ainsi les valeurs centrales (plus hautes) de l’image MIR initiale et 

on renforce ainsi encore les contrastes (la variance spectrale inter-groupe de 

pixels augmente).  

 
5. On fait passer un filtre « Median » sur l’image obtenue avec une fenêtre de calcul de 9 pixels 

par 9.   

Sous ENVI 4.7 > Basic Tools > Band Math > “float (b1) – float (b2)”  
avec  b1 = MIR_initiale   et  b2= MIR_filter_low_pass_1 

 

La taille de la fenêtre de calcul a été choisie de manière à réduire les temps de 

traitements, car la réalisation d’un filtre de la sorte est chronophage. Ce filtre 

consiste à attribuer au pixel situé au centre de la fenêtre de calcul la valeur 

médiane des pixels de la fenêtre de calcul. Cette manipulation permet de lisser 

les variations spectrales internes aux objets distincts et ainsi de diminuer la 

variance intra-groupe.  

 

 L’ensemble de ces manipulations vise ainsi à faciliter l’étape suivante de classification 

via l’algorithme de classification dont le principe de base est de maximiser la variance des 

valeurs de pixels inter-classe et de minimiser celle intra-classe.  
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Deuxième étape : Réalisation d’une classification de Type K-MEANS  
 

 Sachant que G. dewevrei est connu pour être absent des milieux en eau permanente, 

nous avons choisi de masquer les zones de fleuve (eau libre) à partir de la réalisation d’un 

masque binaire obtenu grâce au seuillage de l’indice DWV (automatisation de la création du 

masque sous R cf annexe). En effet, l’indice de DWV (NDVI-NDWI
7
) est connu pour avoir 

des valeurs négatives dans les zones en eau libre [Gond et al., 2004].  

 
Sous ENVI 4.7 >Fenêtre  # Image DWV>Tools > Build Mask…> Options> Import Data 
Range>   Data min value : 0 ___ Data max value : 1 

 

 Nous appliquons ensuite une classification non-supervisée de type K-MEANS 
8
(retenue car la classification ISODATA donne de moins bon résultats) sur l’image masquée, 

en demandant 15 classes et 20 itérations. Après plusieurs tests, nous avons pu valider ce 

nombre de classes et d’itérations qui permettent à la fois d’obtenir une classe de G. dewevrei 

de façon précise tout en évitant des traitements trop longs.  

 

 Cette étape n’a pas été automatisée car les temps de traitements sont beaucoup plus 

important sous R pour réaliser une classification de type K-MEANS que sous ENVI.  

 
  Sous ENVI 4.7 > Classification > Unsupervised > K-Means 
 

 Les classifications peuvent être réalisées les unes après les autres (en mode « batch ») 

via l’option « Queue 
9
» proposée avant de lancer la fin de la manipulation. Les classifications 

seront effectuées les unes après les autres en lançant le batch :  

  
 Sous ENVI 4.7 > File > ENVI Queue Manager >File > Select All > Execute selected 

  

 Nous avons testé pour certaines images des techniques visant à limiter les 

problèmes d’hétérogénéité interne qui pouvait fausser la classification et ainsi parvenir à 

extraire l’ensemble des plaques de mono-dominance qui pouvaient apparaitre sur des tuiles 

hétérogènes: 

 

-  En effet deux cas de figure se sont présentés de façon générale : 

 
1> Les plaques de mono-dominance présentaient des réflectances différentes d’une partie à 

l’autre de l’image en fonction de la présence de nébulosité ou d’aérosols (partie sud de 

l’image ci-dessous): 

                                                 
7
 NDWI= ((R-MIR)/(R+MIR)) 

8
 Nous avons exclu dès le début l’utilisation d’une classification supervisée puisqu’elle qui s’avère peu 

reproductible peut générer de l’erreur (intervention extérieure pour définir les classes de calibration et de 

validation), et coûteuse en temps. 
9
 Il s’agit alors de prédéfinir l’ensemble des images que l’on veut classifier (et les  masques associés) en 

spécifiant le nombre de classes, d’itérations, l’emplacement du fichier de sortie et de finaliser la manipulation 

par « Queue » 
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LC81820592015007LGN00_sr_band6.tif 

 

 

 

2> Les plaques de mono-dominance se confondaient avec des éléments qui n’en été pas car ils 

prenaient des valeurs de réflectance similaire. C’est le cas par exemple des forêts humides de 

la cuvette du Congo (tuile : LC81810592015016), où les plaques de mono-dominance qui 

sont potentiellement des peuplements de G. dewevrei prennent des valeurs de réflectance 

proches d’autres types de végétation présente dans la cuvette.  

 

              Nous avons essayé pour pallier à cela de découper les  images et de lancer une 

classification sur chaque zone découpée séparément afin d’extraire les plaques de mono-

dominance en excluant les éléments confondus de la zone ou en traitant séparément la zone 

avec pollution atmosphérique et la zone sans. Ce procédé n’a pas donné de bons  résulats. 

Nous avons également testé une classification orientée-objet via le logiciel ENVI-EX qui n’a 

pas non plus été très concluante. 

 

            Les techniques ayant permis d’extraire au mieux les plaques ont été les 

suivantes :  

 
1> Nous avons croisé les résultats de classifications obtenues sur deux dates différentes car 

d’une date à l’autre la présence d’aérosols n’était pas située au même endroit. Ceci permet 

ainsi à l’algorithme d’identifier des peuplements à la date T2 non extraits à la date T1.  

LC81820592015007LGN00_sr_band6.tif 

 

2> Nous avons cherché à masquer la zone (à partir da la carte « Central Africa forested 

wetlands ») qui présentait des valeurs de réflectance proche des peuplements mono-

dominants.  

LC81810592015016LGN00_sr_band6.tif. 
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Troisième étape : Réalisation de la classification supervisée de type K-MEANS 
 

 Une fois les classifications obtenues sous forme raster nous les  transférons sous 

ArcGIS pour pouvoir les comparer aux compositions colorées fausse couleur permettant de 

localiser les peuplements de G. dewevrei.  

 

 NB : Les fichiers raster ENVI au format .HDR doivent alors être convertis en format 

.tif pour pouvoir être ouverts sous ArcGIS. Attention lorsque l’on converti un .HDR en .tif , il 

faut veiller à ne pas enregistrer le .tif directement dans le même dossier que le fichier sans 

extension et .HDR (comme le propose automatiquement ENVI) car le logiciel écrase de 

manière automatique le fichier sans extension et le remplace par le .tif. ceci est problématique 

si l’on veut réaliser d’autres traitements sur la classification par la suite (conversion de la 

classe raster vers vecteur, filtre post-classification …) car ENVI ne gère pas le format Tif 

pour les traitements.  

 
 Sous ENVI 4.7 >File>Save file as…> TIFF/Geo TIFF 

 Nous avons ensuite sélectionné pour chaque image la classe dans laquelle les 

peuplements mono-dominants sont contenus et avons fait passé un filtre de type érosion-

dilatation (clump) de fenêtre ( 9 x 9 pixels) afin de corriger les effets de pixels isolés et ainsi 

rendre le processus de vectorisation de la classe plus court. En effet, malgré les prétraitements 

appliqués aux images satellites, il subsiste toujours du bruit symbolisé par la présence de 

pixels mal classés. Pour  corriger ces effets, l’algorithme clump réalise l’examen des pixels de 

voisinage (topologie des objets). Il  tient compte des classes des pixels voisins pour 

déterminer la classe du pixel ou du groupe de pixels, à partir de similarités morphologiques.  

 
 Sous ENVI 4.7 >Classification > Post Classification> Clump classes > Choisir les classes 
concernées et la fenêtre retenue.  

 

 La classe est ensuite convertie en vecteur.  

 
 Sous ENVI 4.7 >Classification > Post Classification> Classification to Vector > Choisir la classe 
 retenue 
 
 Ce traitement a été réalisé pour l’ensemble  

Quatrième étape : Sélection parmi les couches vecteur obtenues 
 

 Les différentes couches de vecteur obtenues
10

 sont ensuite à nouveau nettoyées pour 

réduire tant que possible l’erreur de classification. Pour limiter le risque d’erreur, nous 

n’avons choisi de conserver que les peuplements supérieurs à 1 hectare  via une requête 

attributaire sous ArcGIS. Ce nettoyage final s’est appuyé essentiellement sur de la photo 

interprétation (cf figure ci-dessous
11

),  et sur la comparaison avec les placettes de relevés 

terrains en notre possession.  

  

 

                                                 
10

 Mosaïc 1, annexe.  
11

 Zones ou des peuplements de G. Dewevrei ont été repérés, annexe. La digitalisation plus ou moins précise de 

ces zones (dans Arcgis 10.2:  Drawing > Polygon ) peut permettre en convertissant le dessin, en couche shape 

(Convert Graphics to Feature…) de découper la classe si celle-ci inclus des éléments plus large que le 

peuplement en lui-même (Toolbox>Analysis Tool>Extract>Clip).  
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Figure 10 - Méthode de sélection des classes et des polygones 

 

 

 

 

 

 

 

 

 

 

 

 

Zone de délimitation grossière de peuplements de G. dewevrei 
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RESULTATS & DISCUSSION 

 

  En analysant les classifications obtenues nous constatons des résultats très contrastés.  

 

 Les classifications obtenues à partir des tuiles 183_58, 183_59, 184_58 et 184_59,  

se sont avérées bien trop erronées pour être exploitées (du fait de la pollution atmosphérique 

visible en bleuté ci-dessous) nous n’avons donc pas voulu les conserver d ans la carte finale. 

 

 

 
 Nous avons fait le choix de retenir deux types de zonages, car nous n’avons pas pu 

nettoyer l’ensemble des tuiles contenant les polygones associés aux peuplements de G. 

dewevrei.  

 

 

184_58                     183_58 
 
 
 
 
 
184_59                  183_59 

184_58                     183_58 
 
 
 
 
 
184_59                  183_59 
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Figure 11-Carte des zonages obtenus 

 Le zonage figurant en rouge (tuiles : 182_58, 182_59, 181_58, 181_59) comprend 

uniquement les peuplements denses et purs de G. dewevrei, l’autre en noir  (tuiles ; 185_57, 

185_58, 185_59 ainsi que les reste des tuiles s’étendant de 179_57 à la tuile 174_59)  inclus 

des peuplements plus diffus ou des peuplements inclus dans des zones de forêt mixte.   

 

 Le zonage en  rouge (partie ouest de la carte (Gabon, Cameroun, République du 

Congo) ) représente des peuplements dont la délimitation a été validée visuellement à partir 

des inventiaires terrains, ainsi que de la cartographie réalisée par Gaëlle Viennois alors que le 

zonage noir correspond à une localisation  moins précise qui regroupe à la fois des plaques de 

G. dewevrei moins denses et des zones incluant de la forêt mixte et des plaques de G. 

dewevrei qui n’ont pas pu être dissociées par l’algorithme de classification. On peut estimer 

ce zonage comme une localisation de G. dewevrei potentielle un peu plus fine que les 

délimitations existantes précédentes
12

 mais non exclusive.  

 

 Cette méthode permet de mettre en évidence les zones forestières de mono-dominance. 

Il reste toutefois une large part d’erreur dans la classification  liée à de nombreux paramètres, 

que ce soit les problèmes de nébulosité qui affectent les valeurs de réflectance sur lesquelles 

se base l’algorithme, ou encore l’angle  d’ensoleillement qui un décalage de réflectance entre 

la partie Est et Ouest des images.  

 

                                                 
12

 Zonage large délimité par Nicolas Fauvet et Charles Doumenge (cf carte des tuiles Landsat)   
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 Les moyens à notre disposition pour valider la classification (Cartes de Gaëlle 

Viennois, de Letouzey, de Roth et Heinz, ainsi que les relevés terrains parsemés sur la zone 

d’étude) ne nous permettent d’évaluer que partiellement validité de notre classification.  

 

 La classification n’a pas pu être aussi précise en ce qui concerne la partie Nord et Nord 

est de la République Démocratique du Congo. En effet, la structure même du milieu beaucoup 

plus hétérogène et contrastée (interface forêt- savane, reliquats forestiers inclus dans des 

zones forestières anthropisées) rend la méthode de réhaussement des contrastes moins 

efficace, l’algorithme de classification a alors tendance à regrouper au  sein de la classe qui 

contient les peuplements de G. dewevrei d’autres éléments qui n’en sont pas (G. dewevrei et 

forêt mixte, reliquats forestiers, …). 

 

 Ainsi la méthode utilisée reste coûteuse en temps et nous n’avons pas pu l’automatiser 

complètement. Notre connaissance insuffisante d’ArcGIS et notamment de l’outil Model 

Builder, ne nous a pas permis d’automatiser  réellement
13

 la phase de classification de la 

méthode, ainsi que les processus de création de compositions colorées. Ceci aurait permis de 

gagner du temps nécessaire à la phase de nettoyage de la couche vecteur contenant les 

peuplements de G. dewevrei après classification.   

 

  Par ailleurs, cette méthode  repose sur une large part de photo-interprétation qui 

nécessite de bien connaitre le milieu forestier d’Afrique centrale pour être en mesure de 

discerner les peuplements de G. dewevrei d’éléments qui peuvent présenter un aspect 

similaire (reliquat forestier dans des zones de forêt anthropisée, peuplement forestiers mono-

dominant hygrophile…). Cette phase de compréhension des hétérogénéités de la forêt 

d’Afrique centrale doit-être prise en compte. La réalisation d’un masque à partir de la carte 

« Tropical forests diversity in Central Africa using MODIS data » pourrait permettre de 

limiter les erreurs de classification (cf tableau de proposition de masque en annexe).  

PERSPECTIVES 

 Le vecteur de zonage potentiel obtenu sur la partie Nord,  Nord-Est de la République 

démocratique du Congo peut permettre de réaliser une prochaine classification qui se baserait 

sur un masque binaire issu de ce zonage à l’intérieur duquel il serait possible d’essayer 

d’extraire les peuplements mono-dominants.  

  

 La difficulté d’acquisition d’images nettes dans cette partie du globe rend la 

méthodologie basée sur l’utilisation de canaux optiques limitée. La perspective du couplage 

de cette méthode avec des données radar à 200m de résolution  issues potentiellement de la 

mission Biomass
14

 peut –être une piste intéressante, comme le traitement d’images Sentinelle 

2, dont l’emprise spatiale est plus grande que celles des images LANDSAT8 avec 290km de  

est équivalent et une résolution spatiale de 10m pour les bandes du bleu, vert, rouge et proche 

infra-rouge. Si certains modules de traitement raster permettent de réaliser les corrections 

atmosphériques, l’Agence Spatiale Européenne ne met pas à disposition les images corrigées 

(en réflectance au sol) comme la Nasa peut le faire pour les images LANDSAT notamment.  

                                                 
13

 Nous avons seulement réalisé un batch (réalisation des processus à la suite) sous ENVI mais l’insertion des 

différents paramètres (image, masque, nombre de classes, nombre d’itération) devait être fait à chaque fois 

manuellement contrairement à l’automatisation via le Model Builder.  
14

 Futur satellite radar qui sera envoyé dans l’espace par l’Agence Spatiale Européenne et qui à vocation à sonder 

les forêts tropicales du globe à partir de 2020.  
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ANNEXE 

 

Tropical forests diversity in Central Africa using MODIS data 

 

 

 

 

Numéro de  classe   

Classes incluses dans 

le masque 

 

 

Classes exclues du masque 

 

Wetland 

forests 

 

/ 

 

Forests subjected to relatively 

stable water level, average 

elevation of 304m, 20 m 

maximal canopy height 

 

Forests subjected to 

seasonal flood pulse, 

located alongside 

rivers 

 

/ 

 

Forests subjected to 

seasonal short lasting 

flood pulse, with low 

amplitude, average 

elevation of 306 m, 30 

m maximal canopy 

height 

 

/ 

 

Non-flooded forests, 

average elevation of 

311 m, 40 m maximal 

canopy height 

 

/ 

 

 

 

Terra  

Firme 

forests 

/ Secondary and degraded 

deciduous forests 

Classe_10 

/ Secondary and degraded 

deciduous forests under the 

influence of northern climat 

Classe_7 

/ Mid-altitude evergreen forests 

under the influence of costal or 

sub-montane climate 

Classe_2 

/ Evergreen forests under the 

influence of costal or sub-

montane climate 

Classe_4 

/ Deciduous and gallery forests 

under the influence of southern 

climate 

 

Evergreen forests 

under the influence of 

southern climate 

 

/ 

 

Classe_6 

Semi-deciduous forests 

under the influence of 

southern climate 

/ Classe_9 

Mixed evergreen and 

semi-deciduous forests 

/ Classe_8 

Evergreen forests and 

old-growth secondary 

/ Classe_5 
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Scripts R 

 

########################################################################## 

 #Chaine de traitements pour mise rehaussement des constrastes internes a l’image#### 

########################################################################## 

 

 

###Packages necessaires pour les traitements 

################## 

 

  library('raster') 

  require('sp') 

  require('rgdal') 

 

 

###Localiser le fichier de travail dans lequel  

################ 

 

  setwd("D:/bandes") 

 

   

#### Creer une liste correspondant aux dossiers comprenant l'ensemble des bandes 6 

#### auxquelles on veut appliquer les traitements 

############################   

 

    images<- list.files(".","*.tif")  

     

     

####Creer des repertoire dans le dossier de travail dans lequel il 

#### va mettre les resultats intermediaires et le resultat final 

     

    dir.create("resultats") 

    dir.create("etapes_intermediaires")     

     

############################################################ 

################# Charger la fonction ###################### 

############################################################ 

   

calc_image <- function(x) { 

   

   #### Debut du traitement 

  message("image ",x) 

  b6_E0<-raster(x) 

  b6_E0 

semi deciduous forests 

under the influence of 

northern climate 

Evergreen cloud 

forests 

/  
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  ###Convertir les valeurs des pixels situés sur le poutour de l'image en NA 

  message("  E0") 

  

  ### filtre low pass 

  b6_E1<-focal(b6_E0,w=matrix(1/(45*45),45,45)) 

  

writeRaster(b6_E1,filename=paste("etapes_intermediaires/",x,"_E1.HDR",sep=""),datatype='

INT2S',overwrite=TRUE) 

  message("  E1") 

   

  ### etape 2 

  b6_E2<-b6_E0-b6_E1 

  

writeRaster(b6_E2,filename=paste("etapes_intermediaires/",x,"_E2.HDR",sep=""),datatype='

INT2S',overwrite=TRUE) 

  message("  E2") 

   

   

  ### etape 3 

  b6_E3<-focal(b6_E2,w=matrix(1/(45*45),45,45)) 

  

writeRaster(b6_E3,filename=paste("etapes_intermediaires/",x,"_E3.HDR",sep=""),datatype='

INT2S',overwrite=TRUE) 

  message("  E3") 

   

   

  ### etape 4 

  b6_E4<-b6_E0-b6_E3 

  

writeRaster(b6_E4,filename=paste("etapes_intermediaires/",x,"_E4.HDR",sep=""),datatype='

INT2S',overwrite=TRUE) 

  message("  E4") 

   

   

  ### etape 5 ### filtre median 

  b6_E5<-focal(b6_E4,w=matrix(1,9,9),fun=median) 

  

writeRaster(b6_E5,filename=paste("resultats/",x,"_E5.tif",sep=""),datatype='INT2S',overwrit

e=TRUE) 

  message("  E5") 

   

} 

 

###########################################################################

########### 

#### Pour appliquer la fonction a une seule image (dans le dossier de travail courant) 

####################### 

 

  calc_image("LC81750572014355LGN00_sr_band6.tif") 
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###########################################################################

########### 

#### Pour appliquer la fonction a une liste nommee "images" correspondant au dossier 

rassemblant  

#### les bandes 6 de plusieurs scenes (liste cree plus haut dans le dossier de travail courant) 

####################### 

   

lapply(images, calc_image) 

 

########################################################### 

################ Creation de DWV ############################ 

########################################################### 
 

###Packages necessaires pour les traitements 

library('raster') 

require('sp') 

require('rgdal') 

 

### Indique les chemins d'accès à R pour les dossiers de travail et les documents a utiliser 

################ 

 

#setwd("D:/TRAVAIL") 

#setwd("/mnt/data/home/images/lea/TRAVAIL/") 

 

setwd("C:/TRAVAIL") 

 

################################################################## 

### NB: le dossier de travail doit contenir 3 dossiers  

##  un R (contenant les b4 landsat pour chaque scene), un PIR (b5,idem), un MIR (b6, idem) 

########################### 

 

 

#### Cree les dossiers dans lesquels vont etre stockes les resultats 

################# 

 

  dir.create("DWV") 

  dir.create("NDVI") 

  dir.create("NDWI") 

 

#### Charge la liste des scenes auxquelles ont applique la fonction 

##### (adapter en fonction de la zone etudiee) 

 

  scenes <- list( 

    "LC81790572015018LGN00", 

    "LC81790582015018LGN00", 

    "LC81760572013135LGN01", 

    "LC81830572015014LGN00", 

    "LC81830582015014LGN00", 

    "LC81830592015014LGN00", 
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    "LC81770572014353LGN00", 

    "LC81770572015020LGN00", 

    "LC81770582013350LGN00", 

    "LC81770582014017LGN00", 

    "LC81770592013350LGN00", 

    "LC81840582013351LGN00", 

    "LC81840592013351LGN00", 

    "LC81810572015048LGN00", 

    "LC81810582015016LGN00", 

    "LC81810592015016LGN00", 

    "LC81810602015032LGN00", 

    "LC81810602015048LGN00", 

    "LC81850572015012LGN00", 

    "LC81850582015012LGN00", 

    "LC81850592015012LGN00", 

    "LC81820582013353LGN00", 

    "LC81820592015007LGN00", 

    "LC81780572015027LGN00", 

    "LC81780582013357LGN00", 

    "LC81750572014355LGN00") 

   

  scenes <- list('LC81820592014004LGN00') 

 

###################################################################### 

#######################Charge la fonction############################# 

###################################################################### 

 

creation_DWV<- function(x) { 

 

  ### cree les bandes raster necessaires dans la fonction a partir des scenes 

  ####### 

 

  PIR<-raster(paste("PIR/",x,"_sr_band5",".tif",sep="")) 

  R<-raster(paste("R/",x,"_sr_band4",".tif",sep="")) 

  MIR<-raster(paste("MIR/",x,"_sr_band6",".tif",sep="")) 

 

  #### Creation NDVI 

  ####### 

 

  NDVI<-((PIR-R)/(PIR+R)) 

  

writeRaster(NDVI,filename=paste("NDVI/",x,"_NDVI.envi",sep=""),datatype='FLOAT4S',o

verwrite=TRUE,NAflag=-9999) 

 

  #### Creation NDWI 

  ####### 

 

  NDWI<-((R-MIR)/(R+MIR)) 
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writeRaster(NDWI,filename=paste("NDWI/",x,"_NDWI.envi",sep=""),datatype='FLOAT4S',

overwrite=TRUE,NAflag=-9999) 

 

  ### Creation DWV 

  DWV<-NDVI-NDWI 

  

writeRaster(DWV,filename=paste("DWV/",x,"_DWV.envi",sep=""),datatype='FLOAT4S',ov

erwrite=TRUE,NAflag=-9999) 

 

} 

 

###########################################################################

######################### 

#####################    Lance la fonction     

##################################################### 

###########################################################################

######################### 

 

    lapply(scenes,creation_DWV) 

 

 

 

 

############################################################## 

###### NB:la boucle lapply ne fonction qu'avec une seule liste 

###### (d'ou la necessite de creer une liste de scenes au debut) 

 

 

 

 

 

###########################################################################

################ 

################ Masque eau libre a partir du DWV 

######################################### 

###########################################################################

################ 

 

#### Packages necessaires 

 

library('raster') 

require('sp') 

require('rgdal') 

 

#### Localise le repertoire de travail 

 

#setwd("D:/TRAVAIL") 

  

#setwd("/mnt/data/home/images/lea/TRAVAIL/") 
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setwd("F:/TRAVAIL") 

 

##### cree la liste des DWV 

 

  liste_DWV<-list.files("DWV","*.envi") 

 

####cree un dossier pour mettres les masques obtenus 

  dir.create("Masque_eau_libre") 

 

########################################################################### 

############### Charge la fonction de calcul du masque #################### 

########################################################################### 

 

creation_mask_eau<-function(x) { 

 

  ###creation raster DWV 

  DWV<-raster(file.path("DWV",x)) 

 

  ###encodage masque binaire elimination eau libre (eau libre ->0, reste->1) 

  mask_eau <- DWV>=0 

 

  #####creer les masques 

  

writeRaster(mask_eau,filename=paste("Masque_eau_libre/",x,"_msk_eau.envi",sep=""),datat

ype='INT1U',overwrite=TRUE,NAflag=255) 

} 

 

###################################################################### 

###### Applique la fonction a la liste d'images DWV ################## 

###################################################################### 

 

lapply(liste_DWV,creation_mask_eau) 


